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ARGUMENT 

 

 

Transformările societăţii româneşti din ultimii ani, dezvoltarea şi răspândirea 

informaticii, pătrunderea elementelor moderne de comunicaţii şi tehnologii informatice în ţara 

noastră, impun o pregătire diversificată a tinerilor în acest domeniu de la vârste foarte fragede. 

Si copiii şi tinerii doresc să devină utilizatori avizaţi ai calculatorului. Elevii, viitori 

specialişti în diverse domenii, vor pentru început să utilizeze calculatorul învăţând să-l 

folosească eficient şi corect. 

Auxiliarul ”Microsoft Word și Microsoft Excel. Îndrumător pentru aplicații practice” 

îşi propune familiarizarea elevilor cu elemente de bază ale noilor tehnologii informaţionale şi de 

comunicaţie, urmăreşte pregătirea elevilor în vederea realizării unor documente cu aspect estetic 

deosebit folosind editorul de text Microsoft Word, precum şi  a prelucrării datelor sub formă de 

tabele, a reprezentării grafice a acestora, a realizării de calcule matematice, folosind aplicaţia 

Microsoft Excel. 

De asemenea, un obiectiv important al acestui auxiliar îl constituie exprimarea unui mod 

de gândire creativ în structurarea şi rezolvarea aplicaţiilor, urmărind dezvoltarea unei gândiri 

ordonate şi logice. 

Subiectul acestui auxiliar are caracter teoretic şi aplicativ şi urmăreşte dezvoltarea 

deprinderilor de a lucra individual şi în echipă, înţelegerea impactului tehnologiilor informatice 

în societate, precum şi a conexiunilor dintre informatică şi alte obiecte de studiu, educarea 

elevilor pentru realizarea unor aplicaţii atractive şi dezvoltarea spiritului inventiv şi creator.  

În procesul de predare-învăţare, activitatea va fi orientată pe aplicaţii practice: analiza 

unor situaţii practice (generale sau specifice unui anumit domeniu), identificarea fluxului 

informaţional. 

Auxiliarul este conceput astfel încât să acopere atât explicaţia noţiunilor de baza, cât şi 

înţelegerea şi fixarea lor prin exerciţii şi probleme adecvate, cu grade diferite de dificultate(de la 

uşor la mediu, spre maxim), eliminându-se elementele monotone şi care nu aduc nimic nou, 

prezentându-le astfel încât să antreneze interesul şi fantezia elevilor. 

Am folosit în acest auxiliar, spre exemplificarea fişelor de lucru, modele lucrate cu elevii 

de gimnaziu în anii şcolari anteriori care să constituie un punct de plecare pentru viitorii elevi.  
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CAPITOLUL I 

 

MICROSOFT WORD 

 

1.1. Teste grilă 

 

 

1. Opţiunea Salvare ca … realizează: 

a) salvarea unui document cu nume diferit; 

b) salvarea unui document într-o altă locaţie; 

c) a)  şi b); 

d) a) sau b). 

 

2. Trecerea de la un paragraf la celălalt al unui document se face folosind tasta: 

a) TAB; 

b) SPACE; 

c) ESC; 

d) ENTER; 

 

3. Apăsarea simultană a tastelor                   +             are ca efect: 

a) mutarea punctului de inserare mai sus cu o linie, în aceeaşi poziţie; 

b) mutarea punctului de inserare la începutul liniei; 

c) mutarea punctului de inserare mai sus cu un paragraf; 

d) mutarea punctului de inserare la începutul documentului. 

 

4. Apăsarea simultană a tastelor                     +                       are ca efect: 

 

a) mutarea punctului de inserare mai sus cu o linie; 

b) mutarea punctului de inserare la începutul liniei; 

c) mutarea punctului de inserare mai sus cu un paragraf; 

d) mutarea punctului de inserare la începutul documentului. 

 

Ctrl  

Ctrl Home 
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5. Selectarea unei propoziţii se face executând: 

a) clic oriunde în interiorul propoziţiei; 

b) dublu-clic oriunde în interiorul propoziţiei; 

c) clic dreapta oriunde în interiorul propoziţiei; 

d) se apasă tasta Ctrl şi se execută clic oriunde în interiorul propoziţiei. 

 

6. Selectarea unui cuvânt se face executând: 

a) clic pe acel cuvânt; 

b) dublu-clic pe acel cuvânt; 

c) triplu-clic pe acel cuvânt; 

d) se apasă Ctrl şi se execută clic pe cuvânt. 

 

7. Extensia unui fişier creat în Word este: 

a) .pdf 

b) .jpg 

c) .doc 

d) .exe 

8. Inserarea unui tabel într-un document Word se face urmând paşii: 

a) Vizualizare  Inserare  Tabel; 

b) Editare  Inserare  Tabel; 

c) Tabel  Inserare  Tabel; 

d) Format  Inserare  Tabel. 

 

9. Stabilirea marginilor paginii se face urmând etapele: 

a) Fişier  Iniţializare pagină  Margini; 

b) Fişier  Iniţializare pagină  Dimensiune hârtie; 

c) Fişier  Iniţializare pagină  Sursă hârtie; 

d) Fişier  Iniţializare pagină  Aspect. 

 

10. Copierea şi lipirea se fac cu ajutorul combinaţiilor de taste: 

a) Copiere = Ctrl + A  Lipire = Ctrl + X; 

b) Copiere = Ctrl + V  Lipire = Ctrl + C; 

c) Copiere = Ctrl + A  Lipire = Ctrl + C; 

d) Copiere = Ctrl + C  Lipire = Ctrl + V; 
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11. Examinarea documentului înainte de tipărire se face executând clic pe butonul: 

 

                  a)              b)             c)           d)      

 

12. Selectarea întregului conţinut al unui document se face cu combinaţia de taste: 

a) Ctrl + S; 

b) Ctrl + P; 

c) Ctrl + A; 

d) Ctrl + V. 

 

13. Comanda           are ca efect: 

a) Scindarea celulelor selectate ale unui tabel; 

b) Îmbinarea celulelor selectate ale unui tabel; 

c) Ştergerea celulelor selectate ale unui tabel; 

d) Umplerea cu o culoare a celulelor selectate ale unui tabel; 

 

14. Etapele inserării unei imagini din folderul My Pictures în documentul Word, sunt: 

a) Inserare  Imagine  Din Fişier  My Pictures; 

b) Inserare  Imagine  WordArt  My Pictures; 

c) Inserare  Imagine  My Computer  My Pictures; 

d) Inserare  Imagine  ClipArt  My Pictures. 

 

15. Salvarea unui document se face executând clic pe butonul:      

            

    a)              b)             c)           d)      

 

16. Printarea unui document se face executând clic pe butonul: 

 

    a)              b)             c)           d)      

 

17. Deschiderea unui document nou se face executând clic pe butonul: 

  

    a)              b)             c)           d)      

 



7 
 

18. Opţiunea Forme automate se găseşte în bara: 

a) Desenare; 

b) Formatare; 

c) Standard; 

d) Casetă de controale. 

 

19. Combinaţia de taste Ctrl + Enter are ca efect: 

a) Trecerea la un rând nou; 

b) Trecerea la un paragraf nou; 

c) Trecerea la o pagină nouă; 

d) Trecerea la un alt document. 

 

20. Apăsarea butonului         are ca efect: 

 

a) Evidenţierea caracterelor prin îngroşare; 

b) Evidenţierea caracterelor prin înclinare; 

c) Evidenţierea caracterelor prin subliniere; 

d) Evidenţierea caracterelor prin redimensionare. 

 

21.  Apăsarea butonului          are ca efect: 

 

a) Evidenţierea caracterelor prin îngroşare; 

b) Evidenţierea caracterelor prin înclinare; 

c) Evidenţierea caracterelor prin subliniere; 

d) Evidenţierea caracterelor prin redimensionare. 

 

22. Apăsarea butonului         are ca efect: 

 

a) Evidenţierea caracterelor prin îngroşare; 

b) Evidenţierea caracterelor prin înclinare; 

c) Evidenţierea caracterelor prin subliniere; 

d) Evidenţierea caracterelor prin redimensionare. 
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23. Butonul care are ca efect anularea ultimei comenzi este: 
 

 a)        b)        c)       d)    

 

24. Butonul care are ca efect rotirea unui obiect este: 
 

 a)        b)        c)       d)    

 

25. Inserarea unei căsuţe text se face cu ajutorul butonului: 
 

 a)       b)       c)       d)    

 

26. Butonul care realizează alinierea textului la centru este: 

a)          b)         c)        d)    

27. Butonul care realizează alinierea textului la dreapta este: 

a)          b)         c)        d)    

28.  Cu ce combinaţie de taste se poate alinia un text stânga-dreapta? 

a) CTRL + C; 

b) CTRL + E; 

c) CTRL +L; 

d) CTRL + J. 

 

29. Adăugarea unei bare de instrumente în fereastra Microsoft Word se face din meniul: 

a) Vizualizare; 

b) Editare; 

c) Inserare; 

d) Instrumente. 

 

30. Pentru a aranja în ordine alfabetică numele unor persoane scrise într-un tabel pe o coloană, 

parcurgem următoarele etape: 

a) Selectăm coloana, deschidem meniul Format, alegem Marcatori şi numerotare. 

b) Selectăm coloana, deschidem meniul Tabel, alegem Sortare. 

c) Selectăm coloana, executăm clic-dreapta pe selecţie, alegem Aranjare pictograme după 

nume. 

d) Selectăm coloana, deschidem meniul Fereastră, alegem Aranjare totală. 
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31. Apăsarea butonului    de pe bara cu unelte de desenare are ca efect: 

a) Inserarea WordArt; 

b) Definirea culorii corpului de literă; 

c) Crearea unei casete de text; 

d) Desenarea unui pătrat sau a unui dreptunghi. 

32.  Apăsarea butonului    de pe bara cu unelte de desenare are ca efect: 

a) Inserarea WordArt; 

b) Definirea culorii corpului de literă; 

c) Crearea unei casete de text; 

d) Desenarea unui pătrat sau a unui dreptunghi. 

 

33. Apăsarea butonului    de pe bara cu unelte de desenare are ca efect: 

a) Inserarea WordArt; 

b) Definirea culorii corpului de literă; 

c) Crearea unei casete de text; 

d) Desenarea unui pătrat sau a unui dreptunghi. 

 

34. Apăsarea butonului    de pe bara cu unelte de desenare are ca efect: 

a) Inserarea WordArt; 

b) Definirea culorii corpului de literă; 

c) Crearea unei casete de text; 

d) Desenarea unui pătrat sau a unui dreptunghi. 

 

35. Pentru a şterge caracterul din dreapta cursorului se apasă tasta: 

a) Backspace; 

b) Delete; 

c) End; 

d) Tab. 

 

36. Opţiunea Antet şi subsol se găseşte în meniul: 

a) Tabel; 

b) Inserare; 

c) Editare; 

d) Vizualizare. 
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37.  Pentru a tipări, dintr-un document de 50 de pagini doar paginile 1,5, 34 şi 49, parcurgem 

următoarele etape: 

a) Fişier  Imprimare  alegem  iar în căsuţă scriem 1-5-34-49 

b) Fişier  Imprimare  alegem  iar în căsuţă scriem 1:5:34:49 

c) Fişier  Imprimare  alegem  iar în căsuţă scriem 1,5,34,49 

d) Este imposibil să tipărim numai aceste pagini. 

 

38. Pentru a insera în document obiectul „” parcurgem etapele: 

a) Format  Font  Efecte text; 

b) Instrumente  Plicuri şi etichete; 

c) Format  Stil; 

d) Inserare  Simbol. 

 

39.  Pentru numerotarea sau marcarea cu simboluri a paragrafului se utilizează comanda: 

a) BORDURI ŞI UMBRIRE din meniul FORMAT; 

b) MARCATORI ŞI NUMEROTARE din meniul FORMAT; 

c) MARCATORI ŞI NUMEROTARE din meniul INSERT; 

d) SYMBOL din meniul INSERT. 

 

40.  Pentru aplicarea de chenare sau umbre asupra unui text se foloseşte comanda: 

a) BORDURI ŞI UMBRIRE din meniul FORMAT; 

b) MARCATORI ŞI NUMEROTARE din meniul FORMAT; 

c) MARCATORI ŞI NUMEROTARE din meniul INSERT; 

d) SYMBOL din meniul INSERT. 

 

41. Stabiliţi corespondenţe corecte între combinaţiile de taste din coloana din stânga şi tipul 

de mişcare care se realizează cu aceste combinaţii de taste din coloana din dreapta. 

 

1. CTRL +  

2. CTRL + → 

3. CTRL + Page Down 

4. CTRL + Page Up 

5. CTRL + End 

A. Linia următoare 

B. Începutul liniei 

C. Începutul documentului 

D. Un caracter la stânga 

E. Linia de deasupra 
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6. CTRL + Home 

7. → 

8.  

9.  

10.  

11. End 

12. Home 

13. Page Up 

14. Page Down 

F. Un ecran mai jos 

G. Un caracter la dreapta 

H. Începutul paginii următoare 

I. Sfârşitul documentului 

J. Un cuvânt la stânga 

K. Sfârşitul liniei 

L. Începutul paginii anterioare 

M. Un ecran mai sus 

N. Un cuvânt la dreapta 

 

1.2. Fişe de aplicaţii 

 

Fişa 1. 

 

Deschideţi aplicaţia Microsoft Word şi creaţi un document nou pe care îl salvaţi cu 

numele vostru pe desktop. Realizaţi un afiş care să cuprindă mesaje şi imagini cu tema „Ziua 

Mării Negre” 

Exemple realizate de elevi: 
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Fişa 2. 

 

Deschideţi aplicaţia Microsoft Word şi creaţi un document nou pe care îl salvaţi cu 

numele vostru pe desktop. Realizaţi un desen şi scrieţi un mesaj pentru  „Ziua şcolii mele”, 

folosind obiectele de pe bara de desen, WordArt, borduri de pagină. 

Exemple realizate de elevi: 
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Pătra Maria, clasa a VII-a A 

Text – creaţie proprie 
 

 

Viața este ca un pom: este plantat, 

trebuie îngrijit, supravegheat până când nu 

va mai fi nevoie. Ușor, ușor, se va înălța, 

falnic și frumos, va străluci în splendoarea 

sa, iar apoi , treptat, se va usca. 
Cea mai înfloritoare ramură a Pomului 

Vieții este Ramura Copilăriei, care se 

desface, la rândul ei, în alte câteva 

crenguțe. Despre una din aceste crenguțe 

am dori să vorbim puțin: anii de școală. 

 
Şcoala noastră este o şcoală mică, 

dar cu suflet mare.  

În trei ture, elevii de la clasele I-VIII vin, învață, dezvoltă idei 

împreună cu profesorii, dezbat teme interesante. Poate mai cădem 

din când în când în extaz: este și normal, școala noastră îndeamnă 

la meditație. Oare câți elevi nu au stat în aceleași bănci, nu au privit 

aceiași pereți, nu au auzit glasul aceluiași clopoțel, nu au stat între 

aceiași 4 pereți albi?  

Câte minți nu s-au încins la 

lucrări, privind, din când în când, la 

ceasul de pe perete? Câți elevi nu au 

adus cinste școlii noastre prin 

performanțe deosebite? Câți oameni 

gândesc astăzi plini 

de duioșie la fosta lor 

școală unde au făcut 

gimnaziul? 
 

Aici, în școala noastră, sunt puse amprente 

ale tuturor generațiilor. Orice profesor mai 

înaintat în vârstă ne poate povesti despre sute de 

elevi. Cu toții ne simțim mândri că se va vorbi și 
de noi așa mai târziu, că profesorii pe care îi respectăm își vor 

aminti mereu de noi. 
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Aici se leagă prietenii strânse, 

relații chiar pe viață. Clasele sunt nu 

numai niște colective simple, ci și 
niște familii. Aici toți ne cunoaștem. 

Ne leagă gândul că suntem elevii 

aceleiași școli. Chiar dacă nu toți fac 

performanță, toți se bucură și susțin 

elevii care ne  reprezintă la 

concursuri județene și chiar 

naționale. De câte ori se întorc, 

olimpicii sunt primiți cu aplauze și felicitări 

sincere de la colegi și profesori.  

Într-o bibliotecă întreagă nu ar 
încăpea toate amintirile, toate perioadele 
grele sau frumoase prin care au trecut 

profesorii și elevii noștri. Privim în spate și 
vedem multă trudă pentru oameni 

împliniți, pentru o școală cu viitoare genii. 

Privim în viitor și vedem înfățișarea școlii 

schimbată, omuleții din ea schimbați, dar 

sufletul școlii va rămâne mereu același! 
Aici intrăm curioși, 

neîndemânatici în științe, șovăitori 

la răspunsuri, dar ieșim cu fețele 

luminate, cu sufletele strălucind, 
cu câte un dar aparte din 

personalitatea școlii, iar când ieșim 

știm să urcăm pe scara vieții 
singuri, știm să citim sufletele 

oamenilor, să îi mângâiem. 
 

 
Şcoala noastră, Şcoala Gimnazială "Sf. Dumitru" , este o 

şcoală mică, dar cu suflet mare! 
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Fişa 3. 

Să se realizeze o scrisoare către Moş Crăciun, scrisă cu un font adecvat (scriere de mână 

– de exemplu Lucinda Handwrinting), în interiorul unei forme. La început va fi inserat un tabel 

cu numele si prenume, vârsta şi clasa, şcoala la care învaţă, elevii care vor scrie scrisoarea către 

Moş Crăciun (ca să ştie moşul unde să trimită cadourile). Fundalul celulelor tabelului va avea 

diferite culori. 

Pentru a scrie dorinţele voastre moşului trebuie să folosiţi casete text (Text Box). Se va insera in 

scrisoare o poza cu Moş Crăciun din fişierul vostru de lucru 

 Exemplu: 
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Fişa 4 

 

Deschideţi un document Word nou şi salvaţi-l cu numele vostru pe desktop. 

Folosind instrumentele de pe bara de desenare, WordArt, operaţiile de formatare a caracterelor, 

imagini din galeria Word sau de pe Internet realizaţi un desen pentru sărbătorile de iarnă. 

Exemple realizate de elevi 
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Fişa 5 

 

Deschideţi un document Word nou şi salvaţi-l cu numele vostru pe desktop. 

Folosind instrumentele de pe bara de desenare, WordArt, operaţiile de formatare a caracterelor, 

imagini din galeria Word sau de pe Internet realizaţi un desen cu tema „Valentine’s Day”. 

Exemple realizate de elevi 
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Fişa 6 

 

Deschideţi un document Word nou şi salvaţi-l cu numele felicitare.doc  pe desktop. 

Folosind instrumentele de pe bara de desenare, WordArt, operaţiile de formatare a caracterelor, 

imagini din galeria Word sau de pe Internet realizaţi o felicitare pentru ziua de  „1 Martie”.  

 Exemple realizate de elevi: 
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Fişa 7 

 

Deschideţi un document Word nou şi salvaţi-l cu numele felicitare.doc  pe desktop. 

Folosind instrumentele de pe bara de desenare, WordArt, operaţiile de formatare a caracterelor, 

imagini din galeria Word sau de pe Internet realizaţi o felicitare pentru ziua de  „8 Martie”. 

Exemple realizate de elevi: 
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Fişa 8 

 

Deschideţi un document Word nou şi salvaţi-l cu numele planete.doc  pe desktop. 

Folosind instrumentele de pe bara de desenare, WordArt, operaţiile de formatare a caracterelor, 

imagini din galeria Word sau de pe Internet realizaţi un afiş cu tema Sistemul Solar.   

Exemple realizate de elevi: 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

a VI-a B 
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Fişa 9 

Deschideţi un document Word nou şi salvaţi-l cu numele planete.doc  pe desktop. 

Folosind instrumentele de pe bara de desenare, WordArt, operaţiile de formatare a caracterelor, 

imagini din galeria Word sau de pe Internet realizaţi un poster cu tema ”Spune NU violenței”.   

Exemplu realizate de elevi: 

  



26 
 

Fişa 10 

Deschideţi un document Word nou şi salvaţi-l cu numele planete.doc  pe desktop. 

Folosind instrumentele de pe bara de desenare, WordArt, operaţiile de formatare a caracterelor, 

imagini din galeria Word sau de pe Internet realizaţi un poster/afiș cu tema SOS Natura ”Școala 

Zero Waste”.   

Exemple realizate de elevi: 
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Fișa 11 

Exemple de pagini din revista proiectului ”Scoala Zero Waste” realizată cu elevii în 

cadrul orelor de CDS integrat ”Informatica în viața cotidiană”. 
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36 
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Fişa 12 

 

Deschideţi un document Word nou şi salvaţi-l cu numele diagrama.doc  pe desktop. 

Realizaţi diagrame (nomograme sau smartart-uri) de forme diferite alegându-vă una dintre 

următoarele teme: animale sălbatice, flori de primăvară, maşinile preferate, sportivi preferaţi, 

piramida nevoilor, arborele genealogic. Formataţi diagramele, astfel încât să nu existe două 

forme la fel prin schimbarea culorilor, a fundalurilor, a imaginilor selectate pentru fundal.  

Exemple realizate de elevi: 
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Fişa 13 

 

Creaţi un document Word nou cu următoarele setări de pagină: format A4, margini: sus 2 

cm, jos 2 cm, stânga 3 cm, dreapta 2 cm, orientare verticală, antet 1,5 cm subsol 1,5 cm şi îl 

salvaţi cu numele site.doc pe desktop. 

Editaţi următorul text respectând operaţiile de formatare indicate: font Arial, dimensiune 

12, culoare roşu, alinierea textului stânga-dreapta, distanţa între rânduri de 1,5, scrierea cu bold 

pentru prima clasificare şi cu italic pentru cea de a doua clasificare.  

Fiecare tip de organigramă se va scrie cu o altă culoare. 

Titlul se va scrie cu majuscule, aliniat la centru, boldat şi înclinat şi va avea o umbră de 

culoarea gri. 

 
 

ETAPE DE REALIZARE A UNUI SITE 

 

 Etapa de identificare cu exactitate a obiectivului; 

 Etapa de culegere a informaţiilor 

 Etapa de selectare a informaţiilor relevante 

 Etapa de proiectare a structurii site-ului: 

 Organizaţi informaţiile culese pe categorii; 

 Stabiliţi numărul de pagini; 

 Stabiliţi conţinutul paginilor; 

 Stabiliţi relaţiile dintre pagini. 

Realizaţi următoarea schemă în care fiecare formă sa aibă o formatare diferită (culoarea şi 

dimensiunea caracterelor, culoarea de fundal, forma şi culoarea liniilor, grosimea săgeţilor): 

 

DISPOZITIVE DE INTRARE 

TASTATURA DISPOZITIVE CU INTRARE DIRECTĂ 

Dispozitive de indicare Dispozitive de scanare Dispozitive de intrare 
vocală 
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Fişa 14 

 

Creaţi un document Word nou cu următoarele setări de pagină: format A4, margini: sus 2 

cm, jos 2 cm, stânga 3 cm, dreapta 2 cm, orientare verticală, antet 1,5 cm subsol 1,5 cm şi îl 

salvaţi cu numele funcţii.doc pe desktop. 

Editaţi următorul text respectând operaţiile de formatare indicate: font Arial Black, 

dimensiune 14, culoare albastru, alinierea textului stânga-dreapta, distanţa între rânduri de 1,5,  

Titlul se va scrie cu majuscule, aliniat la centru, boldat şi înclinat folosind un WordArt. 

 

 

 În rezolvarea diferitelor aplicaţii, deseori avem nevoie să realizăm anumite calcule 

matematice asupra datelor numerice dintr-un tabel. 

Funcţiile reprezintă formule complexe  ce efectuează  anumite operaţii asupra unei serii 

indicate de valori.  

Fiecare funcţie constă din următoarele elemente: 

  semnul “ = “ indică faptul că ceea ce urmează este o funcţie (formulă) 

  numele funcţiei – indică operaţia care va fi efectuată; 

  argumentul funcţiei – indică adresele celulelor asupra cărora va lucra funcţia.  

Microsoft Word pune la dispoziţie un pachet de 18 funcţii predefinite, dintre care cele 

mai des utilizate sunt:  

 SUM (argument) – calculează suma unei serii de numere; 

 PRODUCT(argument) – calculează produsul unei serii de numere; 

 AVERAGE (argument) – calculează media aritmetică a unei serii de numere; 

 MAX (argument) – calculează maximul dintr-o serie de numere; 

 MIN (argument) – calculează minimul dintr-o serie de numere; 

 COUNT (argument) – numără toate celulele din serie care conţin valori numerice; 

 

Argumentul unei funcţii poate fi reprezentat de o celulă sau un grup de celule şi poate fi 

exprimat în două feluri: 

1) Prin adresele celulelor pentru care se aplică funcţia, separate prin „;” dacă acestea nu sunt 

adiacente (ex. A1;B2;C3) sau prin domeniul reprezentat de celule, dacă acestea sunt 

consecutive(ex. A1:C3).  
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2) Prin argumente de poziţie care indică locul unde se află situate celulele, pentru care se 

calculează funcţia, faţă de celula în care se va afişa rezultatul funcţiei. Acestea sunt: 

a) LEFT  - se referă la toate celulele din rând aflate în stânga celulei în care se 

calculează rezultatul funcţiei;  

b) RIGHT - se referă la toate celulele din rând aflate în dreapta celulei în care se 

calculează rezultatul funcţiei; 

c) ABOVE - se referă la toate celulele din coloană aflate deasupra celulei în care 

se calculează rezultatul funcţiei; 

d) BELOW - se referă la toate celulele din coloană aflate sub celula în care se 

calculează rezultatul funcţiei; 

 

Fişa 15 

 

Creaţi un document Word nou cu următoarele setări de pagină: format A4, margini: sus 2 

cm, jos 2 cm, stânga 3 cm, dreapta 2 cm, orientare verticală, antet 1,5 cm subsol 1,5 cm şi îl 

salvaţi cu numele reţele.doc pe desktop. 

Editaţi următorul text respectând operaţiile de formatare indicate: font Times New 

Roman, dimensiune 14, culoare verde, alinierea textului stânga-dreapta, distanţa între rânduri de 

20 de puncte,  

Titlul se va scrie cu majuscule, aliniat la centru, boldat şi înclinat folosind un WordArt, 

într-o casetă de text. 

 

 

 

 

 În funcţie de accesul la reţea: 

 reţele private; 

 reţele publice; 

 În funcţie de aria de răspândire a calculatoarelor: 

 reţele locale (LAN); 

 reţele metropolitane (MAN); 

 reţele globale (WAN).  

 În funcţie de strategia de funcţionare: 

 reţele de la egal la egal; 

 reţele client/server. 



43 
 

Realizaţi următoarea schemă în care fiecare formă sa aibă o formatare diferită (culoarea şi 

dimensiunea caracterelor, culoarea de fundal, forma şi culoarea liniilor, grosimea săgeţilor): 

 

 

 

Fişa 16 

 

1. Deschideţi aplicaţia Microsoft Word şi realizaţi tabelul următor respectând formatările de 

tip îngroşat, înclinat, centrat şi umbrire: 

 

CHELTUIELI 

Nr. crt. Tip cheltuieli Ianuarie Februarie Martie Total 

1.  Telefon 35,03 23,69 42,38 101,10 

2.  Întreţinere  56,58 49,04 45,02 150,64 

3.  Autoturism  78,50 85,70 74,60 238,80 

4.  Energie electrică 15,20 14,30 13,80 43,30 

5.  Alimente  268,90 289,00 297,80 855,70 

6.  Divertisment  45,00 45,00 55,00 143,00 

7.  Utilităţi  86,00 92,00 102,00 280,00 

8.  Alte cheltuieli 22,00 32,00 36,00 90,00 

Total:  pe lună 607,21 628,72 666,60 1902,53 

 

2. Salvaţi fişierul cu numele cheltuieli.doc în directorul personal. 

3. Iniţializaţi pagina astfel: orientarea paginii tip vedere, margini egale de 2,5 cm, format 

A4. 

Probleme de sănătate 

Probleme de vedere 
şi migrene 

Dureri de spate şi ceafă 

Efectul provocat de repetarea 
aceloraşi gesturi 

Efectul câmpului 
electromagnetic 

Stări de nervozitate 
datorate zgomotului 
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4. Formataţi caracterele astfel: 

- titlul tabelului Comic Sans Ms, mărime 18, bold, centrat; 

- antetul tabelului şi ultima linie, font Arial, mărime 12, bold, centrat; 

- interiorul tabelului font Tahoma, mărime 12, aliniere dreapta. 

5. Introduceţi automat datele în coloana Nr. crt, prin autonumerotare. 

6. Sortaţi crescător datele din tabel după coloana Total. 

7. Inseraţi în antetul paginii, la centru textul Aplicaţii la tabele. 

8. Inseraţi în subsolul paginii, la stânga data şi ora curentă. 

9. Formataţi fiecare coloană a tabelului astfel încât să aibă altă culoare de fundal. 

10. Stabiliţi o bordură de tip linie triplă de culoare roşu, pentru exteriorul tabelului şi de tip 

linie dublă pentru interiorul tabelului. 

11. Realizaţi o captură de ecran a acestui document şi inseraţi-o în partea de jos a 

documentului, sub tabel. 

12. Salvaţi modificările şi închideţi documentul. 

 

Exemplu pentru tabel 

CHELTUIELI 

Nr. crt. Tip cheltuieli Ianuarie Februarie Martie Total 

1.  Energie electrică 15,20 14,30 13,80 43,30 

2.  Alte cheltuieli 22,00 32,00 36,00 90,00 

3.  Telefon 35,03 23,69 42,38 101,10 

4.  Divertisment  45,00 45,00 55,00 143,00 

5.  Întreţinere  56,58 49,04 45,02 150,64 

6.  Autoturism  78,50 85,70 74,60 238,80 

7.  Utilităţi  86,00 92,00 102,00 280,00 

8.  Alimente  268,90 289,00 297,80 855,70 

Total:  pe lună 607,21 628,72 666,60 1902,53 
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Fişa 17 

1. Deschideţi aplicaţia Microsoft Word şi realizaţi tabelul următor: 

SITUAŢIA PE SEMESTRUL I 

S
it

u
aţ

ia
 e

le
v
il

o
r 

p
e 

se
m

 I
 

Nr. crt. Nume 

     Medii semestrul 1 pe discipline 

Medie sem I Romana Engleza Mate Info 

1 Ana 9 10 7 10 9 

2 Bogdan 7 8 7 9 7,75 

3 Eva 10 10 9 10 9,75 

4 Corina 6 5 5 7 5,75 

5 Matei 7 8 8 7 7,5 

Medii pe disciplina 7,8 8,2 7,2 8,6 7,95 

2. Salvaţi fişierul cu numele medii.doc în directorul personal. 

3. Iniţializaţi pagina astfel: orientarea paginii tip vedere, margini egale de 2,5 cm, format A4. 

4. Formataţi caracterele astfel: 

- titlul tabelului Comic Sans Ms, mărime 16, bold, centrat, WordArt ; 

- antetul tabelului şi ultima linie, font Arial, mărime 12, bold, centrat; 

- interiorul tabelului font Tahoma, mărime 12, aliniere dreapta. 

5. Introduceţi automat datele în coloana Nr. crt, prin autonumerotare. 

6. Inseraţi în antetul paginii, la centru textul Aplicaţii la tabele. 

7. Inseraţi în subsolul paginii, la stânga data şi ora curentă. 

8. Formataţi fiecare coloană a tabelului astfel încât să aibă altă culoare de fundal. 

9. Stabiliţi o bordură de tip linie dublă de culoare albastru, pentru exteriorul tabelului şi de 

tip linie punctată de culoare roşu pentru interiorul tabelului. 

10. Salvaţi modificările şi închideţi documentul. 

Exemplu pentru tabel 

S
it

u
a
ţi

a
 e

le
v
il

o
r 

p
e 

se
m

 I
 

Nr. crt. Nume 

     Medii semestrul 1 

Medie sem I Romana Engleza Mate Info 

1 Ana 9 10 7 10 9 

2 Bogdan 7 8 7 9 7,75 

3 Eva 10 10 9 10 9,75 

4 Corina 6 5 5 7 5,75 

5 Matei 7 8 8 7 7,5 

Medii pe disciplina 7,8 8,2 7,2 8,6 7,95 
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Fişa 18 

1. Creaţi un document Word nou cu următoarele setări de pagină: format A4, margini: sus 2 cm, 

jos 2 cm, stânga 3 cm, dreapta 2 cm, orientare verticală.  

2. Inseraţi un tabel de forma următoare: 

Nr. crt. Produs Stoc iniţial Cantitate Preţ 

Cod Denumire Intrată Ieşită 

1 111 Mere 1000 3450 3000 3 

2 222 Pere 1200 5444 5000 4 

3 333 Portocale 950 2500 2000 3 

4 444 Banane 670 1200 1000 6 

5 555 Struguri 320 900 700 12 

6 666 Ananas 56 580 400 15 

7 777 Gutui 1300 2000 1800 20 

 

3. Aplicaţi tabelului formatările necesare pentru ca acesta să aibă următorul aspect: 

Nr. crt. Produs Stoc iniţial Cantitate Preţ 

Cod Denumire Intrată Ieşită 

1 111 Mere 1000 3450 3000 3 

2 222 Pere 1200 5444 5000 4 

3 333 Portocale 950 2500 2000 3 

4 444 Banane 670 1200 1000 6 

5 555 Struguri 320 900 700 12 

6 666 Ananas 56 580 400 15 

7 777 Gutui 1300 2000 1800 20 

 Formatări: 

 Capul de tabel să fie aliniat la centru, boldat, font Arial Black, culoare roşu, dimensiune 

12. 

 Pentru textul din tabel se va folosi fontul Times New Roman, dimensiune 12, culoare 

albastru, italic, aliniere la centru. 

 Conturul exterior al tabelului să fie de tip linie triplă de culoare roşu. 

 Conturul interior al tabelului să fie de tip linie întreruptă de culoare portocaliu, grosimea 

liniei la alegere. 

 Culoarea de umbrire (de fundal) a tabelului să fie galben. 

4. Ştergeţi din tabel rândul corespunzător produsului „Portocale”. 

5. Adăugaţi la sfârşitul tabelului două rânduri şi le completaţi corespunzător. 

6. Salvaţi documentul cu numele vostru pe desktop. 
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Fişa 19 

 

1. Creaţi un document Word nou cu următoarele setări de pagină: format A4, margini: sus 2 cm, 

jos 2 cm, stânga 3 cm, dreapta 2 cm, orientare verticală.  

2. Inseraţi un tabel de forma următoare: 

 

Nr. 

crt. 

Scoală Date elevi Total 

elevi 

Alte date 

Clasa Medii 

Corigenţi Promovaţi cu medii 

De 5 Între 5-7 Peste 7 

1 Șc. Nr. 18 V A 0 5 10 15 30 Nu sunt 

elevi  

repetenţi 

2 Șc. Nr. 18 VI A 1 6 8 15 30 

3 Șc. Nr. 18 VII A 2 6 10 10 28 

4 Șc. Nr. 18 VIII A 0 8 8 10 26 

 

3. Aplicaţi tabelului următoarele formatări: 

 Capul de tabel să fie aliniat la centru, boldat, font tahoma, culoare mov, dimensiune 12. 

 Pentru textul din tabel se va folosi fontul Times New Roman, dimensiune 12, culoare 

grena, bold, italic, aliniere la centru. 

 Conturul exterior al tabelului să fie de tip linie dublă, de culoare mov, grosime 3 pct. 

 Conturul interior al tabelului să fie de tip linie punctată de culoare roşu, grosimea liniei la 

alegere. 

 Culoarea de umbrire să fie bleu. 

 

5. Adăugaţi la sfârşitul tabelului 3 rânduri şi le completaţi corespunzător. 

6. Salvaţi documentul cu numele vostru pe desktop. 

 

Exemplu de rezolvare 

 

Nr. 

crt. 

Scoală Date elevi Total 

elevi 

Alte date 

Clasa Medii 

Corigenţi Promovaţi cu medii 

De 5 Între 5-7 Peste 7 
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1 Șc. Nr. 18 V A 0 5 10 15 30 

Nu sunt 

elevi  

repetenţi 

2 Șc. Nr. 18 VI A 1 6 8 15 30 

3 Șc. Nr. 18 VI B 2 6 10 10 28 

4 Șc. Nr. 18 VI C 0 8 8 10 26 

5 Șc. Nr. 18 VII A 0 1 4 20 25 

6 Șc. Nr. 18 VIII A 1 2 5 18 26 

7 Șc. Nr. 18 VIII B 4 3 6 14 27 

 

Fişa 20 

 

1. Creaţi un document Word nou pe care îl salvaţi cu numele vostru pe Desktop. 

2. Inseraţi un tabel cu 7 coloane şi 9 rânduri şi completaţi-l cu următoarele date: 

Nume elev Med_sem1 Med_sem2 Medie 

generala 

Abs_sem1 Abs_sem2 Total_absenţe 

A 7 8 7,5 45 20 65 

B 8 9 8,5 12 8 20 

C 9 10 9,5 25 15 40 

D 5 6 5,5 36 12 48 

Produsul 

mediilor pe 

sem 1  

2520     

Cea mai mare 

medie 

generala 

  9,5   

Cea mai mica 

medie pe sem 

2 

 6    

Nr. de medii 

semestriale 

încheiate 

8     

Folosind funcţii prezentate anterior (SUM, AVERAGE, MAX, MIN, COUNT),  

completaţi câmpurile rămase libere: 

 Media generală pentru fiecare elev; 

 Nr. total de absenţe pentru fiecare elev; 

 Produsul mediilor pe sem 1 

 Cea mai mare medie generala 

 Cea mai mica medie pe sem 2 

 Nr. de medii semestriale încheiate. 
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Fişa 21 

 

Creaţi un document Word nou pe care îl salvaţi cu numele matematica.doc pe Desktop. 

Editaţi în acest document următoarele aplicaţii matematice, apoi salvaţi modificările realizate. 

1. Dintre numerele 
 

 
 şi 
 

 
, mai mare este ………………….. 

2. Rezultatul calculului: √   √   √  este ………………………… 

3. Media aritmetică a numerelor: 
 

 
 
 

 
 
 

 
 este …………. 

4. Apreciaţi cu adevărat sau fals rezultatul următoarelor expresii: 

a. √    nu este număr raţional; 

b.  √   (  √ )     

5. Aflaţi     astfel încât: 

a. 
 

 
 
 

 
 
 

 
 

b. √   √  √  

6. Calculaţi: 

 
  

 
 
 
 
 

 
 
 
 
 

  

  
 
 
      

 
 
    

 
 

 
 
    

 
 
   

  

 

         

            
  

 

7. Să se rezolve următoarele sisteme de ecuaţii: 

{
     
     

                                     {
          
         

 

 

8. Apreciaţi cu adevărat sau fals rezultatul următoarelor expresii: 

a) Dacă         şi        atunci          

b) Descompunerea în factori a expresiei [(   )(   )      ] este egală cu 

(   )  . 
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CAPITOLUL II 

 

MICROSOFT EXCEL 

 

2.1. Teste grilă 

 

1. Fişierele din Excel se numesc: 

a) registre de calcul; 

b) foi de calcul; 

c) ferestre de calcul; 

d) celule de calcul. 

 

2. Workbook înseamnă: 

a) foi de calcul; 

b) foi de diagrame; 

c) registru de lucru; 

d) grafic. 

 

3. Sheet înseamnă: 

a) foaie cu diagramă; 

b) foaie de calcul; 

c) registru de lucru; 

d) fişier Excel. 

 

4. Coloanele în Excel se numerotează cu: 

a) cifre romane; 

b) litere mari; 

c) cifre arabe; 

d) nici una din cele de mai sus. 

 

5. Liniile (rândurile) în Excel se numerotează cu: 

a) cifre romane; 

b) litere mari; 

c) cifre arabe; 

d) nici una din cele de mai sus. 
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6. Celula B7 se găseşte la: 

a) intersecţia liniei B cu coloana 7; 

b) intersecţia liniei 7 cu coloana B; 

c) intersecţia liniei 7 cu coloana 7; 

d) intersecţia liniei B cu coloana B; 

 

7. Programul Excel se deschide iniţial cu: 

a) 1 foaie de calcul; 

b) 2 foi de calcul; 

c) 3 foi de calcul; 

d) 4 foi de calcul. 

8. Îmbinarea mai multor celule se face cu ajutorul butonului: 

a)   b)   c)   d)  

 

9. Inserarea unei diagrame (grafic) se face cu ajutorul butonului: 

a)   b)   c)   d)  

 

10. Înainte de scrierea unei formule matematice într-o celulă se pune semnul: 

a) =  b) +  c) /  d) ? 

 

11. Inserarea unei funcţii în Excel se face cu ajutorul butonului: 

a)   b)   c)   d)  

 

12. Calcularea unei sume în Excel se face cu ajutorul butonului: 

a)   b)   c)   d)  

 

13. Funcţia SUM calculează: 

a) media aritmetică; 

b) procentul dintr-un număr; 

c) suma unor celule, linii, coloane; 

d) maximul dintre mai multe numere. 
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14. Funcţia AVERAGE calculează: 

a) media aritmetică; 

b) procentul dintr-un număr; 

c) suma unor celule, linii, coloane; 

d) maximul dintre mai multe numere. 

 

15. Funcţia PRODUCT calculează: 

a) diferenţa unor numere; 

b) produsul unor numere; 

c) media aritmetică a unor numere; 

d) suma unor numere. 

 

16. Formatarea numerelor conţinute în celule se face executând paşii: 

a) clic-dreapta pe celula respectivă sau pe selecţia mai multor celule  Formatare celule  

Număr; 

b)  clic-dreapta pe celula respectivă sau pe selecţia mai multor celule  Formatare celule  

Hyperlink; 

c) clic-dreapta pe celula respectivă sau pe selecţia mai multor celule  Formatare celule  

Modele; 

d) clic-dreapta pe celula respectivă sau pe selecţia mai multor celule  Formatare celule  

Protecţie. 

 

17. Formula =SUM(A1:A6)/6 are ca efect: 

a) însumarea (adunarea) numerelor din celulele A1, A2, … , A6; 

b) împărţirea la 6 a fiecărui număr din celulele de la A1 la A6; 

c) calcularea mediei aritmetice a numerelor din celulele A1, până la A6; 

d) înmulţirea numerelor cuprinse în celulele de la A1 la A6. 

18. Funcţia =IF(B121000; 75%; 50%) se traduce prin: 

a) dacă numărul din celula B12 este mai mare decât 1000 atunci afişează 75%, dacă nu 

afişează 50%; 

b) dacă numărul din celula B12 este mai mare decât 1000 atunci afişează 50%, dacă nu 

afişează 75%; 

c) dacă numărul din celula B12 este mai mare decât 1000 atunci calculează 75% din el; 

d) dacă numărul din celula B12 este mai mare decât 1000 atunci calculează 50% din el; 
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19. Alinierea orizontală, verticală şi încadrarea textului se face astfel: 

a) clic-dreapta pe celula respectivă  Formatare celule  Font; 

b) clic-dreapta pe celula respectivă  Formatare celule  Bordură; 

c) clic-dreapta pe celula respectivă  Formatare celule  Aliniere; 

d) clic-dreapta pe celula respectivă  Formatare celule  Modele. 

 

20. Salvarea unui fişier Excel se face din meniul: 

a) inserare; 

b) vizualizare; 

c) editare; 

d) fişier. 

 

21. Umplerea unor celule selectate cu o culoare se face folosind butonul: 

a)   b)  c)   d)  

 

22. Alegerea culorii fontului într-o celulă sau mai multe celule selectate se face cu ajutorul 

butonului: 

a)   b)  c)   d)  
 

23. Afişarea unui anumit număr de zecimale pentru un număr dintr-o celulă sau mai multe 

celule se face urmând paşii: 

a) clic-dreapta pe celula respectivă sau pe selecţia mai multor celule  Formatare celule  

Număr  Număr de zecimale; 

b) clic-dreapta pe celula respectivă sau pe selecţia mai multor celule  Formatare celule  

Aliniere  Număr de zecimale; 

c) clic-dreapta pe celula respectivă sau pe selecţia mai multor celule  Formatare celule  

Modele  Număr de zecimale; 

d) această operaţie nu este posibilă. 

 

24. Pentru a insera pe o linie sau pe o coloană o serie se parcurg etapele: 

a) Inserare  Umplere  Serie; 

b) Editare  Umplere  Serie; 

c) Vizualizare  Umplere  Serie; 

d) Format  Umplere  Serie. 
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25. Extensia unui fişier Excel este: 

a) .doc 

b) .ppt 

c) .xls 

d) .mp3 

26. Aplicarea bordurilor unui tabel se poate face cu ajutorul butonului: 

a)   b)   c)   d)  

 

27. Pentru a redenumi o agendă de lucru alegem: 

a) opțiunea Save as din meniul File; 

b) opțiunea Save Workspace din meniul File; 

c) opțiunea Send to din meniul File. 

 

28. Ce formulă trebuie utilizată pentru a calcula valoarea minimă din domeniul cuprins între 

celulele B5 și B23: 

a) MIN(B5:B23); 

b) MINIM(A5,A23); 

c) MINIM(A5:A23); 

d) MINIMUM(A5:A23). 

 

29. Ce formulă trebuie utilizată pentru a calcula valoarea maximă din domeniul cuprins între 

celulele A5 și A23: 

a) MAXIMUM(A5:A23); 

b) MAXIM(A5,A23); 

c) MAXIM(A5:A23); 

d) MAX(A5:A23). 

 

30. Doriți să mutați conținutul coloanei C.  

Ce opțiune alegeți din meniul contextual: 

a) Copy; 

b) Cut; 

c) Insert; 

d) Column with. 
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31. Doriți să copiați foaia de calcul în registrul de calcul.xls. 

Unde faceți clic pentru această operațiune? 

a) Sheet1; 

b) Create a copy; 

c) OK; 

d) Cancel. 

 

 

32.  Pentru a salva un registru de calcul ca șablon, in secțiunea Save as Type alegeți opțiunea: 

a) Microsoft Excel Workbook; 

b) Web Page; 

c) Template; 

d) Text. 

 

33. Pentru a introduce în antetul foii de calcul data curentă, se selectează butonul: 

a)                b)   c)   d)  

 

34. Pentru a introduce în subsolul foii de calcul ora curentă, se selectează butonul: 

a)                b)   c)   d)  

 

35. Pentru a stabili dimensiunea marginilor unei foi de calcul, din fereastra de dialog Page 

Setup se alege opțiunea: 

a) Page; 

b) Header/Footer; 

c) Margins. 

 

36. Pentru a stabili dimensiunea antetului/subsolului unei foi de calcul, din fereastra de dialog 

Page Setup se alege opțiunea: 

a) Page; 

b) Header/Footer; 

c) Margins. 
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37. Care dintre următoarele comenzi din meniul File se utilizează pentru listarea unei foi de 

calcul: 

a) Print Area; 

b) Print Preview; 

c) Print. 

d) Print to file. 

 

38. Pentru ștergerea liniilor/coloanelor selectate, se alege comanda: 

a) Delete, din meniul contextual; 

b) Clear, din meniul contextual; 

c) Clear din meniul Edit; 

d) Tasta Delete. 

 

39. Alinierea datelor din celule la centru se face prin selectarea butonului: 

 

a)                  b)                       c)                     d)  

 

 

40. Alinierea datelor din celule la dreapta se face prin selectarea butonului: 

 

a)                  b)                       c)                     d)  

 

 

41. Alinierea datelor din celule la stanga și la dreapta se face prin selectarea butonului: 

 

a)                  b)                       c)                     d)  

 

 

42. Pentru a modifica dimensiunea unei coloane, din meniul contextual se alege comanda: 

a) Hide; 

b) Format cells; 

c) Column with; 

d) Insert. 
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43.  În caseta de dialog Format cells, pentru a stabili mărimea caracterelor, selectați meniul: 

a) Number; 

b) Aligment; 

c) Font; 

d) Border; 

 

 

44. În caseta de dialog Format cells, pentru a stabili marginile celulelor (stil de linie și 

culoare), selectați meniul: 

a) Number; 

b) Aligment; 

c) Font; 

d) Border; 

 

45. Pentru a ascunde un rând sau o coloană, din meniul contextual se alege opțiunea: 

a) Clear contents; 

b) Hide; 

c) Unhide; 

d) Paste special. 

 

 

46. Pentru a insera o imagine dintr-un folder în foia de calcul, se selectează meniul: 

a) Edit - > Picture; 

b) Insert - > Object; 

c) Insert -> Picture; 

d) Format -> Picture. 

 

47. Pentru a insera o diagramă dintr-un folder în foia de calcul, se selectează meniul: 

a) Edit - > Picture; 

b) Insert - > Chart; 

c) Insert -> Picture; 

d) Format -> Chart. 
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48. Căutarea rapidă a datelor dintr-un domeniu selectat se realizează prin selectarea meniului: 

a) Edit - > Find; 

b) Insert - > Find; 

c) File -> Find; 

d) Format -> Find. 

 

49. În Excel, care dintre următoarele afirmaţii este falsă: 

a) argumentele funcţiilor pot fi precizate prin valori sau prin adresa celulelor; 

b) argumentele funcţiilor pot fi obligatorii sau opţionale; 

c) argumentul unei funcţii nu poate fi o altă funcţie; 

 

50. Care dintre următoarele expresii nu este o formulă: 

a) = 100 + A1; 

b) A1 + A2; 

c) = 1 + 1; 

 

2.2. FIŞE DE LUCRU 

 Fişa 1  

 

1.. Deschideţi aplicaţia Microsoft Excel şi realizaţi orarul clasei, după modelul: 

 

2. Iniţializaţi foaia de calcul astfel: orientarea paginii tip vedere, mărimea paginii A4, marginile 

din stânga şi din dreapta 2,5 cm, marginile de sus şi de jos 2 cm, centrare orizontală şi verticală 

pe pagină. 

3. Formataţi textul tabelului folosind diferite fonturi, culori, stiluri de font, mărimi. 

4. Umpleţi celulele tabelului cu diferite culori de fundal. 

5. Formataţi bordurile tabelului cu diferite stiluri de linii şi culori. 

6. Inseraţi în antetul paginii, în secţiunea din stânga textul „Orarul clasei” iar în secţiunea din 

dreapta data şi ora sistemului. 

7.  Salvaţi tabelul în directorul vostru cu numele orar.xlsx. 
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 Fişa 2 

 

1. Deschideţi aplicaţia Microsoft Excel şi realizaţi următorul tabel: 

 

 

2. Iniţializaţi foaia de calcul astfel: orientarea paginii tip vedere, mărimea paginii A4, marginile 

din stânga şi din dreapta 2,5 cm, marginile de sus şi de jos 2 cm, centrare orizontală şi verticală 

pe pagină. 

3. Formataţi textul tabelului folosind diferite fonturi, culori, stiluri de font, mărimi. 

4. Umpleţi celulele tabelului cu diferite culori de fundal. 

5. Formataţi bordurile tabelului cu diferite stiluri de linii şi culori. 

6. Inseraţi în antet paginii, în secţiunea din stânga textul „Tabel cheltuieli” iar în subsol în 

secţiunea din dreapta numărul de pagină. 

7. Redenumiţi foaia de calcul cu numele cheltuieli. 

8.  Salvaţi tabelul în directorul vostru cu numele cheltuieli.xlsx. 

  

 Fişa 3 

 

I. Răspundeţi la întrebări completând spaţiile punctate. 

 

1) Selectarea unei linii se realizează executând clic stânga pe …………………………… 

2) O agendă de lucru este formată din …………………………………………………… 

3) Pentru a crea un antet/subsol se selectează …………………………………………… 

……..…………………………………………………………………………………………… 

4)Inserarea unei coloane într-o foaie de calcul se realizează astfel: 

…………………………………………………………………………………………………… 

………………………………………………………………………………………………… 
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II. Corelaţi prin săgeţi elementele din coloana din stânga cu cele din coloana din dreapta:  

A)  

1) Codul ataşat liniilor este:  a) A..Z, AA..AZ, BA..BZ…  

2) Codul ataşat coloanelor este:                                    b) 1, 2, 3, … 

 

B) 

1) Alinierea datelor la marginea dreaptă a celulei;                 a) 

2) Alinierea datelor la marginea stângă a celulei;                  b) 

3) Alinierea datelor la centru în celulă;                                      c) 

 

C) 

1)                                                                 a) afişează numărul paginii;   

2)       b) permite formatarea caracterelor; 

3)                                                                c) afişează ora curentă. 

 

III) Descrieţi procedurile de formatare aplicate următoarelor date: 

 

Nr. crt. Nr. contract Valoare fără TVA TVA 

1 BD307 3500 560 

2 DC508 5700 912 

3 S007 1100 176 

TOTAL: 10300 1648 

  

astfel încât rezultatul să fie: 

 

Nr. crt. Nr. contract Valoare fără TVA TVA 

1 BD307 3500 560 

2 DC508 5700 912 

3 S007 1100 176 

TOTAL: 10300 1648 
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 Fişa 4  

 

I. Răspundeţi la întrebări completând spaţiile punctate. 

 

1)Selectarea unei coloane se realizează executând clic stânga pe 

…………………………………………………………………………………………………… 

2) O foaie de calcul este formată din ……………………………………………………… 

3) Setarea marginilor unei foi de calcul se realizează prin ………………………………… 

 …………………………………………………………………………………………………….  

4) Inserarea unei linii într-o foaie de calcul presupune efectuarea următorilor paşi: 

……………………………………………………………………………………………………

…………………………………………………………………………………………………… 

 

II. Corelaţi prin săgeţi elementele din coloana din stânga cu cele din coloana din dreapta:  

A)  

 1) Copy:                a) Comandă ce permite mutarea textului selectat din Clipboard 

                                        în zona dorită de utilizator;                                                                                              

2) Cut;                   b) Comandă ce permite copierea textului selectat în memoria                                                           

                                 tampon Clipboard; 

3) Paste;               c) Comandă ce permite mutarea selecţiei în memoria tampon  

                            Clipboard; 

B) 

1) Scrierea datelor italic; a)  

2) Scrierea datelor boldat; b) 

3) Scrierea subliniată a datelor; c) 

 

C) 

1)    a) afişează ora curentă;   

2)                      b) permite formatarea caracterelor; 

3)    c) afişează data curentă. 
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III) Descrieţi procedurile de formatare aplicate următoarelor date: 

 

Nr. crt. Nr. contract Valoare fără TVA TVA 

1 BD307 3500 560 

2 DC508 5700 912 

3 S007 1100 176 

TOTAL: 10300 1648 

  

astfel încât rezultatul să fie: 

 

Nr. crt. Nr. contract Valoare fără TVA TVA 

1 BD307 3500 560 

2 DC508 5700 912 

3 S007 1100 176 

TOTAL: 10300 1648 

 

 Fişa 5  

 

1.. Deschideţi documentul XB.xls aflat pe Desktop 

2.. Redenumiţi foaia 1 cu numele „Temperaturi martie” 

3.. Ştergeţi foile 2 şi 3 din registru. 

4.. Stabiliţi marginile foii „Temperaturi martie” de 2 cm.  

5.. Formataţi datele din celulele B2:E12 (ca în exemplul din aceeaşi foaie)  respectând 

următoarele elemente de formatare: 

a) îmbinaţi celulele B2:E2. Textul afişat să fie îngroşat şi aliniat centrat în celulă. 

b) antetul de tabel să fie aliniat centrat, la mijlocul celulei pe verticala, îngroşat, subliniat 

cu două linii, font Arial, culoare albastru închis,  având bifată opţiunea Incadrare Text  

şi pe fond gri; 

c) datele de tip numeric să fie aliniate la dreapta si scrise fara zecimale. Se va utiliza fontul 

Calisto MT cu dimensiuna 12, culoare neagră; 

d) aplicaţi tabelului un chenar cu stilul liniei groasă de culoare neagră pentru partea 

exterioară iar pentru partea interioară de culoare albastru deschis cu stil de linie 

punctată. 

6.. Salvaţi modificările aduse foii de calcul. 
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 Fişa 6 

 

1. Deschideţi aplicaţia Microsoft Excel şi realizaţi următorul tabel: 

 

N
u

m
e 

cl
a
sa

 Anul 2009-2010 

Sem I Sem II 

Popescu M. 
VI A 

8,0 7,0 

Ionescu I. 9,5 7,0 

Popa A. 
VI C 

8,0 6,0 

Anghel P. 8,0 10,0 
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2.. Respectaţi următoarele elemente de formatare: 

a) fontul utilizat este Times New Roman, dimensiune 10, înclinat; 

b) toate datele sunt centrate în celule; 

c) celulele primului rând au fondul galben; 

d) numerele sunt afişate cu o singură zecimală; 

e) linia chenarului este dublă şi de culoare roşie; 

f) liniile interioare sunt simple, de culoare neagră; 

g) primele două celule au textul înclinat cu 90 grade. 

3. Redenumiţi foaia de calcul în care aţi creat tabelul „Note” şi salvaţi registrul de lucru cu 

numele „Note elevi”. 

4.  Salvaţi tabelul în directorul vostru cu numele tabel.xlsx. 

 

 

Fişa 7  

 

1.. Deschideţi aplicaţia Microsoft Excel şi realizaţi un tabel după modelul de mai jos: 

 

2. Iniţializaţi foaia de calcul astfel: orientarea paginii tip portret, mărimea paginii A4, marginile 

din stânga şi din dreapta 2cm, marginile de sus şi de jos 2 cm, centrare orizontală pe pagină. 

3. Completaţi tabelul cu datele a 10 elevi. 

4. Inseraţi datele din coloana Nr. Crt. în mod automat. 

5. Formataţi textul tabelului astfel: 

a) antetul tabelului şi ultima linie: mărime 20, font Arial, Bold, aliniere la centru; 

b) interiorul tabelului: mărime 14, font Tahoma, Italic, aliniere la stânga. 

6. Formataţi bordurile tabelului cu diferite stiluri de linii şi culori. 

7. Calculaţi pentru fiecare elev media celor trei note şi apoi media generală pe clasă.  

8.  Salvaţi tabelul în directorul vostru cu numele tabel_elevi.xlsx. 
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  Fişa 8 

 

1. Deschideţi aplicaţia Microsoft Excel şi realizaţi un tabel după modelul de mai jos: 

 

2. Iniţializaţi foaia de calcul astfel: orientarea paginii tip vedere, mărimea paginii A4, marginile 

din stânga şi din dreapta 2 cm, marginile de sus şi de jos 2 cm, centrare orizontală pe pagină. 

3. Completaţi tabelul cu datele a 10 elevi. 

4. Inseraţi datele din coloana Nr. Crt. în mod automat. 

5. Formataţi textul tabelului astfel: 

a) antetul tabelului şi ultima linie: mărime 14, font Arial, Bold, aliniere la centru; 

b) interiorul tabelului: mărime 12, font Tahoma, Italic, aliniere la stânga. 

6. Formataţi bordurile tabelului cu diferite stiluri de linii şi culori. 

7. Calculaţi pentru fiecare elev media la fiecare disciplină şi memoraţi rezultatele în următoarele 

patru coloane ale tabelului.  

8. Afişaţi rezultatele obţinute de elevi în ordinea descrescătoare a mediilor. 

9.  Salvaţi tabelul în directorul vostru cu numele tabel_medii.xlsx. 

  

 

 Fişa 9 
 

1. Deschideţi aplicaţia Microsoft Excel şi realizaţi un tabel după modelul de mai jos: 

 

 

 

 

 

 

 

 

2. Formataţi bordurile tabelului cu diferite stiluri de linii şi culori. 

3. Calculaţi pentru fiecare familie totalul cheltuielilor dintr-o lună.  
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4. Calculaţi suma totală care trebuie plătită la Întreţinere, Curent şi Telefon pentru toate familiile. 

5. Afişaţi familiile în ordinea descrescătoare a cheltuielilor. 

6. Afişaţi toate familiile care plătesc la telefon mai mult de 300000 lei. 

7.  Salvaţi tabelul în directorul vostru cu numele cheltuieli.xlsx. 

  

 Fişa 10  

 

1. Deschideţi aplicaţia Microsoft Excel şi realizaţi un tabel după modelul de mai jos: 

 

 

 

 

 

 

2. Formataţi bordurile tabelului cu diferite stiluri de linii şi culori. 

3. Calculaţi pentru fiecare elev media notelor.  

4. Calculaţi media notelor obţinute de elevi la fiecare disciplină. 

5. Afişaţi elevii alfabetic, în ordinea descrescătoare a mediilor. 

6. Afişaţi toţi elevii care au obţinut la matematică note peste 8. 

7.  Salvaţi tabelul în directorul vostru cu numele cheltuieli.xls. 

 

Fişa 11 

 

1. Creaţi o agendă de lucru nouă. În a doua foaie de calcul creaţi un tabel  cu structura din 

imagine.  
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2. Folosind funcţii prezentate anterior (SUM, AVERAGE, MAX, MIN, COUNT, IF),  

completaţi câmpurile rămase libere. 

3. Câmpul Med_generală – se calculează ca medie aritmetică a celor două medii semestriale 

(med_sem1, med_sem2). 

4. Câmpul total_abs – se calculează ca sumă între absenţele de pe cele două semestre (Abs_sem1 

şi Abs_sem2). 

5. Câmpul Rezultat  va fi completat cu „admis” dacă elevul obţine med_generală >=5  şi 

“respins” dacă med_generală este <5. 

6. Afişaţi toţi elevii admişi. 

7. Copiaţi într-o altă foaie de calcul toţi elevii respinşi. 

8. Redenumiţi foaia de lucru în care aţi lucrat cu numele statistica şi apoi realizaţi o copie a 

acestei foi. 

9.  Salvaţi agenda în directorul vostru cu numele situaţie_medii.xls. 

 

Fişa 12  

 

1. Creaţi o agendă de lucru nouă pe care o salvaţi cu numele vostru pe desktop. 

2. Introduceţi în foaia de lucru1 următoarele date: 

 

 

 

 

3. Reprezentaţi grafic datele din tabelul de mai jos, folosind următoarele tipuri de diagrame: 

a) diagramă de tip coloană 

b) diagramă de tip bară 

c) diagramă de tip linie. 

d) Diagramă de tip suprafaţă. 

4. Salvaţi modificările aduse agendei de lucru. 
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Fişa 13  

 

1. Creaţi o agendă de lucru nouă pe care o salvaţi cu numele vostru pe desktop. 

2. Introduceţi în foaia de calcul 1 următoarele date: 

 

Gradul de audienţă a unor posturi de televiziune 

 AUGUST SEPTEMBRIE OCTOMBRIE NOIEMBRIE 

PRO TV 36 35 27 25 

TVR 1 22 24 26 24 

ANTENA 1 30 32 35 30 

PRIMA TV 15 20 22 20 

HBO 25 20 30 35 

3. Reprezentaţi grafic datele din tabelul de mai jos, folosind următoarele tipuri de diagrame: 

a) diagramă de tip coloană 

b) diagramă de tip bară 

c) diagramă de tip linie. 

4. Salvaţi modificările aduse agendei de lucru. 

  

 Fişa 14  

 

1. Creaţi o agendă de lucru nouă pe care o salvaţi cu numele vostru pe desktop. 

2. Introduceţi în foaia de calcul 1 următoarele date: 

 

Gradul de audienţă a unor posturi de televiziune 

 AUGUST SEPTEMBRIE OCTOMBRIE NOIEMBRIE 

PRO TV 36 35 27 25 

TVR 1 22 24 26 24 

ANTENA 1 30 32 35 30 

PRIMA TV 15 20 22 20 

HBO 25 20 30 35 

3. Reprezentaţi grafic datele din tabelul de mai jos, folosind următoarele tipuri de diagrame: 

a) diagramă de tip coloană 

b) diagramă de tip bară 

c) diagramă de tip linie. 

4. Salvaţi modificările aduse agendei de lucru. 
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 Fişa 15  

 

1.. Creaţi o agendă de lucru nouă pe care o salvaţi cu numele vostru pe desktop. 

2.. în foaia de lucru 1 realizaţi următorul tabel ce reprezintă rezultatele obţinute de elevii unei 

clase la testarea iniţială la informatică. 

Note 1 2 3 4 5 6 7 8 9 10 Media 

Frecvenţa 0 0 0 0 3 4 8 6 5 2 7,42 

3.. Calculaţi media pe clasă obţinută la această testare, folosind următoarea formulă: 

Media = 
28

f*n ii = 7,42        unde ni reprezintă nota iar fi reprezintă frecvenţa notei ni. 

4.. Reprezentaţi cu ajutorul diagramelor ponderea notelor şi frecvenţa notelor obţinute de elevi la 

această testate iniţială. 

 Exemplu: 

 

 

 

 

 

 

 

 

 

 

 

Figura 1. Poligonul frecvenţelor   Figura 2. Ponderea notelor obţinute   
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